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 NEWS FLASH!!!

Issues on electronic mail (e-mail) inter-
est most of us since it is fast becoming a
major part of person-to-person or busi-
ness-to-business communication. Yet,
only few understand how messages
reach an Inbox via the Internet. 

Messages coming from the Internet pass
through a number of components within
a messaging system before it reaches
the recipient’s Inbox. The component
that facilitates the routing of messages
upon receipt from the Internet until they
are delivered to their intended recipients
is called the MTA (Message Transfer
Agent). 

The Internet Exchange Messaging
Server 4.1 is equipped with an MTA,
which is composed of the following
components: Input/Output Channels,
Preprocessor component and Shared
Message Queue. Its key features
include the Monitor Control Responder
and the Dialup Scheduler.

SYSTEM COMPONENTS  
Input Channels
A channel is a path through which mes-
sages flow. It makes use of a specific
protocol to format and transfer mes-
sages. Internet Exchange MTA makes
use of a number of input channels in
receiving messages from the Internet or
other messaging systems, like cc:Mail
and Notes Mail. These include:

• SMTPD - for messages received
from the Internet via the standard
SMTP

• BSMTPIN - for messages received
via POP3 connection

• CCOUT - for messages received
from the cc:Mail environment

• NOTESOUT - for messages
received from the Lotus Notes
environment

Note: CCOUT or NOTESOUT
export messages from the cc:Mail
or Notes environment and input
them into the Internet Exchange
MTA.

• DL - for messages sent to a distri-
bution list. When messages from
the Internet are received by the
input channels, they are tempo-
rarily stored in the input queue
after which they shall be fetched
by the Preprocessor for further
processing

• WEB MAIL CLIENT - for mes-
sages coming from the Local Mes-
sage Store using the Web Mail
Client.

Output Channels
The Internet Exchange also makes use
of a number of output channels in rout-
ing messages to the Internet or other
messaging systems, like cc:Mail and
Notes Mail. These include the follow-
ing: SMTPC, BSMTPOUT, DL,
LOCAL, CCIN and NOTESIN. These
channel processors are responsible for
fetching messages from the MTA
Shared Message Queue and delivering
them to their intended recipients. 

Preprocessor
Once the Preprocessor receives mes-
sages, it will perform directory look up
from the Directory Server to determine
the proper channels/connectors defined
to route the message to its intended
recipients. After determining the rout-
ing information for each message, the
Preprocessor will perform virus scan-
ning, spam control and automatic dis-
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claimer insertion on the messages. 

The Preprocessor engine consists of the following modules:
AntiVirus, SpamArchive, SpamDelete, SpamBounce, Loop-
Detection and AutoInsertion. Each module has its own Chan-
nel Action Matrix, which defines all the possible input/output
channel combinations to perform a specific action (e.g. virus
scanning) on messages that flow through the system. 

MTA Shared Message Queue
After the Preprocessor processes the messages, the messages
are temporarily stored in the MTA Shared Message Queue
before   they   are   delivered   by the   different   input/output
channels to their intended recipients. 

KEY FEATURES
Monitor Control Responder
The enhanced Monitor Control (MC) Responder user interface
allows the system administrator to monitor and control the sta-
tus of various Internet Exchange components. It allows the
system administrator to Start or Stop the Responder, which
will thereby start or stop all of the installed modules all at the
same time. 

The administrator may also activate certain options, such as
the Auto Start, Auto Restart and Auto Stop for a specific com-
ponent. There is also a field where the user can define the Wait
Time, which is the amount of time the MC Responder has to
wait before running the component. Furthermore, this web
interface also has a button for changing the status of the com-
ponents from Stop to Running or vise-versa.

Dialup Scheduler
Having a dedicated Internet connection is ideal, however, in

certain cases, it may be impossible or impractical to maintain a
permanent Internet connection. In these cases, it is desirable to
use a dial-up mechanism, which will establish a connection to
an ISP (Internet Service Provider) at a particular time to down-
load and upload messages to and from the Internet.

The Internet Exchange MTA utilizes the RAS (Remote Access
Service) dial-up mechanism. RAS is the service by which the
Windows Operating System allows the local system to dial
and connect to another peer over the Internet. The MTA ini-
tiates RAS through the Dialup Scheduler that supports the fol-
lowing functions:

• Provides a user interface to enable the system adminis-
trator to configure dial-up schedules and other RAS
connection-related information.

• Performs RAS dial up at the scheduled dial-up time.

• Performs RAS connection hang up at the scheduled
hang-up time.

MESSAGE FLOW
How messages flow through the MTA can be described using
two scenarios. First, when messages from the Internet are
received by the Internet Exchange, and second, when mes-
sages from the Internet Exchange are sent to the Internet. 

Internet to Internet Exchange
Internet Exchange receives messages coming from the Internet
through either the SMTPD (Simple Mail Transfer Protocol
Daemon) or BSMTP (Batch Simple Mail Transfer Protocol)
input channels. (See Figure 1). These messages are then sub-
mitted to the MTA Input Queue.  From  the  input queue, the

        
 2

   

                                 2

                                         Figure 1: Message Flow for Incoming Messages
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messages are fetched by the Preprocessor, which performs
directory look up from the Directory Server. If the domain
name (e.g. @domain.com) of the recipient address is defined
in the Directory Server, the Preprocessor will then perform
further look up, this time to obtain the channels/connectors
needed to route the message within the local Internet
Exchange MTA. After this information is acquired, a new
internal message envelope with proper routing information is
created for the message. When the proper routing information
for all the messages is determined, the messages will undergo
Preprocessor operations, such as virus scanning, spam checks 
and disclaimer insertion depending on the configuration of the
system administrator. After the pre-processing is complete, the
processed messages are inserted into the MTA Shared Mes-
sage Queue where they are later fetched by their respective
channel processors for actual delivery to their intended recipi-
ents.

If the domain name of the recipient address is not defined
within the Directory Server (e.g. @domain.com), the Prepro-
cessor will pass the message to the SMTPC (Simple Mail
Transfer Protocol Client), which will relay the message to
another MTA in the Internet. 

Internet Exchange to Internet  
Messages created within the Internet Exchange domain, bound
for the Internet (see Figure 2), are directly submitted by the
MTA to the Preprocessor, which will then perform  virus scan-
ning, spam checks and disclaimer insertion on messages
depending on the configuration of the system administrator.
After the pre-processing is complete, the processed messages

are inserted into the MTA Shared Message Queue to be picked
up later by the SMTPC or BSMTP output channels (BSMT-
POUT). SMTPC or BSMTPOUT then route the messages to
the next MTA on the Internet for eventual delivery to its
intended recipients.

SAMPLE ROUTING OF MESSAGES
Internet Exchange to cc:Mail Environment 
Message received by the Internet Exchange destined for
cc:Mail environment are fetched by the CCIN channel, which
obtains proper routing information of the message within the
cc:Mail environment. The CCIN channel processor determines
the routing information of the message by first translating the
recipient address, for example, “jdoe@domain.com” to its
equivalent cc:Mail username, which is “John Doe”. After
translating the recipient address, CCIN will perform directory
look up to determine the receive permission of “John Doe”.
After determing the receive permission, CCIN will convert
“jdoe@domain.com” to “john doe” and use this username in
performing an address book lookup to the cc:Mail Post Office.
If CCIN finds that username “john doe” is included in the
address book of the cc:Mail Post Office, CCIN will forward
the message to the cc:Mail Post Office. Then, the cc:Mail Post
Office will deliver the message to the user’s mailbox “john
doe”.

cc:Mail Environment to Internet Exchange 
A message coming from the cc:Mail environment destined for
the Internet Exchange is processed by the CCOUT channel.
CCOUT will fetch the message from the cc:Mail Internet Post-
Office queue, which obtains proper routing information of the
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                                         Figure 2: Message Flow for Outgoing Messages
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message. For example, a registered cc:Mail user named “John
Doe” sent a message to an Internet Exchange local user “sam-
ple@ima.com”, the CCOUT channel processor translates the
sender’s cc:Mail username  “John Doe” to its equivalent Inter-
net address  by performing a directory look up in the Directory
Server. If the sender’s address does not exist in the Directory
Server, CCOUT will translate the sender’s address by using
the “Default Mapping” method. This method will translate the
sender’s address in either of the following format: Firstname_
Lastname@domain.com or Firstname.Lastname.domain.com.

After  translating the sender’s address, CCOUT will export the
message from the Internet Post Office Queue to the Internet
Exchange, which will then route the message to its intended
recipient “sample@ima.com”. 

Internet Exchange to Notes Environment
If a  message received by the Internet Exchange is destined for
a Lotus Notes user “John Doe/Notes Domain” whose Internet
address is “jdoe@domain.com”, NOTESIN will connect to the
Notes Server to perform Notes Public Address Book (PAB)
lookup in the Notes Server. If “John Doe/Notes Domain”
exists in the Notes Address Book , NOTESIN translates the
recipient Internet address “jdoe@domain.com” to its equiva-
lent Notes address “John Doe/Notes Domain”. Then,
NOTESIN will perform directory look up from the Directory
server to determine the receive permission of “John Doe”.
After determining the receive permission, the message will be
imported from Message Queue to the Notes Server, which will
then deliver the message to “John Doe/Notes Domain” mail-
box.

Notes Environment to Internet Exchange 
A message coming from the Notes environment destined for
the Internet Exchange is processed by the NOTESOUT chan-
nel. NOTESOUT will fetch the message from the Notes
Server, which obtains proper routing information of the mes-
sage. For example, a registered Notes user named “John Doe/
Notes Domain” sent a message to an Internet Exchange  local
user “sample@ima.com”, NOTESOUT channel processor
translates the sender’s Notes username, which is “John Doe/
Notes Domain” to its equivalent Internet address by perform-
ing a directory look up in the Directory Server. If the sender’s
address does not exist in the Directory Server, NOTESOUT
will translate the sender’s address by using the “Default Map-
ping” method. This method will translate the sender’s address
in either of the following format: Firstname_Lastname@dom-
ain.com or Firstname.Lastname.domain.com.

After  translating the sender’s address, NOTESOUT will
export the message from the Notes Server to the Internet
Exchange, which will then route the message to its intended
recipient “sample@ima.com”. 

Mail Destined to Internet Exchange Local Environment
If a message received from the Internet is destined to the Inter-
net Exchange local channel, the Local Mail Delivery Agent
(LMDA) will fetch the messages from the MTA Shared Mes-
sage Queue. Before delivering the messages to the Mesage
Store, LMDA  will check the recipient’s home directory for a
Mailsort filter file for sorting incoming messages. Based on
the filter rules defined in the filter file, the LMDA will auto-
matically deliver the message to the recipient’s preferred
folder or forward the message to a new e-mail address on a per
message basis. 

Mail Destined to a Distribution List Local Channel
Messages destined to a distibution list local channel are
received by the Internet Exchange via the SMTPD or BSMT-
PIN channel. The messages are then retrieved by the Prepro-
cessor module, which performs directory look up from the
Directory Server to determine whether they are messages des-
tined for a mailing list (e.g. jazz@ima.com). Upon receiving
the messages destined for a mailing list, the DL Manager per-
forms a directory look up using also the Directory Server to
identify the addresses of all the mailing list’s members. It will
also create an internal message envelope, with the original
message to be sent to the “jazz@ima.com” mailing list mem-
bers. Then, the messages will be forwarded to the Preproces-
sor, which will perform anti-virus scanning, anti-spam checks
and disclaimer insertion. After the message pre-processing, the
messages will be inserted to the MTA Shared Message Queue.
LMDA will fetch the messages from the MTA Shared Mesage
Queue and subsequently forward the messages to all
“jazz@ima.com” mailing list members. 
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For more information about the MTA, please go to 
the following references:

• http://www.ima.com/product/v4/mta/ie4mta.pdf
(Internet Exchange 4.0 Messaging Server Compo-
nents: Message Transfer Agent)

• http://www.ima.com/faq/msgsrv/routing.html
(Internet Exchange Message Routing FAQ)

• http://www.ima.com/pdf/adminman2.pdf 
    (Messaging Server Administrator’s Guide)
• http://www.ima.com/faq/msgsrv/dialup.html

(Internet Exchange Messaging Server Dialup Sched-
uler FAQ)

• http://www.ima.com/faq/msgsrv/responder.html
(Internet Exchange Messaging Server Monitor Control
(Responder FAQ)



ast month, we  discussed  how
Internet Exchange works with
the different IMAP-capable cli-

ents. We specifically enumerated the
steps on how to create an IMAP account
using the different e-mail clients, such
as the Microsoft Outlook Express,
Eudora Mail, Pegasus Mail and Net-
scape Messenger. Please go to http://
www.ima.com/pdf/ienews/vol3no7.pdf
for more details.

This month, we list down the steps on
how you can efficiently manage your
folders using any of the said mail cli-
ents.  

Outlook Express (v.4.x / v.5.x)
Creating Folders 
1. Click the File menu. Select Folder

and click on New. The Create Folder
dialog box will appear.

2. In the Folder name input text box,
type the folder name (e.g. Sales).
Select the user account (John Doe)
where you wish to create a new
folder. Then, click the OK button.
The user account (John Doe) will
now have a folder (i.e., Sales). See
Figure 1.

Note: You may also create a folder by
simply right clicking the user account
John Doe. A drop-down menu will
appear. Select on  New Folder. The
Create Folder dialog box  will
appear. Repeat the procedure in step
2.

Creating Sub-folders 
To create a sub-folder, follow the proce-
dure in creating folders. However, in
step 2, you must select the folder (e.g.
Sales) where you wish to create a sub-
folder (e.g. Marketing).

Creating Folders/Sub-folders in your
Shared Account 
You can also create a folder/sub-folder
in your shared account. To do this, right

click on the shared account and follow
the same steps in creating a  folder.

Renaming Folders/Sub-folders
1. Right click the folder name you wish

to rename. A drop-down menu will
appear. 

2. Select Rename. The Rename Folder
dialog box will appear.

3. Type the new folder name in the
Folder Name input text box. 

4. Click the OK button. 

Note: You cannot rename the Inbox,
Outbox, Sent Items, Deleted Items or
Drafts folders. 

Deleting Folders/Sub-folders
You may delete a folder/sub-folder
either using the Edit menu, the drop-
down menu or the Delete command.
. 
To delete a folder/sub-folder using the
Edit menu, select the folder/sub-folder
you wish to delete. Click the Edit menu
then, select Delete. 

To delete using the drop-down menu,
right click on the folder/sub-folder you
wish to delete. A drop-down menu will

appear. Select Delete.

To delete a folder/sub-folder using the
Delete command, select the folder/sub-
folder you wish to delete. Then, press
the Delete command on your keyboard.

Note: Deleting the main folder (e.g.
Sales) will also delete its sub-folder
(e.g. Marketing). You cannot delete
the Inbox, Outbox, Sent Items,
Deleted Items or Drafts folders. 

Hiding/Showing Folders
To hide or show folders, you may either
use the Tools menu or the drop-down
menu. 

To hide or show folders using the Tools
menu, click the Tools menu. Select
IMAP Folders. The Show/Hide IMAP
Folders screen will appear. Select the
folder you wish to hide or show, then
click the Hide or Show button. 

To hide or show folders using the drop-
down menu, select the folder you wish
to hide or show. The drop-down menu
will appear. Select Hide or Show. 

Folder Compaction
Folder compaction allows you to
remove any wasted space on your disk. 

Highlight of the Month  

Managing Your Folders Using Various IMAP Clients

L
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                                  Figure 1:  Outlook Express Mail Client



To compact your folder, click the File
menu. Highlight Folder and click on
Compact or Compact All Folders. 

The Compact command will remove
any wasted space on the particular
folder that is selected, while the Com-
pact all Folders will automatically
compact all the folders and sub-folders
in your account.

Eudora Mail (v.4.x)
Creating Mailboxes 
In Eudora, mailboxes refer to the top-
level folder in your Inbox.  

To create a mailbox, follow the proce-
dure below:

1. From the Mailbox menu, select the
account name (e.g. Dominant). See
Figure 2.  Then, click on New. The
New Mailbox dialog box will appear.

2. Type the new mailbox folder (e.g.
Sales). Tick the Make it a folder
check box. Then, click the OK but-
ton. 

Note: You may also create a mailbox
by right clicking the account name
(e.g. Dominant). A drop-down menu
will appear. Click on New. The New
Mailbox dialog box will appear.
Then, repeat the procedure in step 2.
This is also applicable in creating
folders.

Creating Folders
Folders in Eudora refer to the sub-fold-
ers of the mailboxes.

To create a folder, follow the procedure
below:

1. From the Mailbox menu, select the
account name (e.g. Dominant).
Then, select the mailbox folder (e.g.
Inbox) where you wish to  create a
sub-folder (e.g. Sales). The New
Mailbox dialog box will appear. 

2. Follow step 2 in creating mailboxes. 

Creating Multiple Mailboxes and
Folders in Your Shared Account
To create a mailbox or folder in your
shared account, simply follow the same
steps in creating mailboxes or folders.

Renaming Mailboxes or Folders
1. Right click on the mailbox or folder

name. A drop-down menu will
appear.  Select Rename. 

2. Type the new name of the mailbox or
folder. Press Enter to implement the
new settings or ESC to cancel it.

Deleting Mailboxes or Folders
1. Right click on the mailbox or folder

name. A drop-down menu will
appear. 

2. Choose Delete. 

Note: You may also simply high-
light the mailbox or folder name
then, press the Delete key on your
keyboard. If you choose to remove
a mailbox where messages are still
stored or a folder where other
mailboxes or folders are stored, a
confirmation message will appear.
You may either click the Remove it
button to remove all the items
selected or the Cancel button to
cancel the deletion. Messages
within the selected mailbox or
folder will also be deleted.

Hiding/Showing Mailboxes and Fold-
ers
To hide mailboxes and folders, right
click on any mailbox or folder name. A
drop-down menu will appear. Click on
Hide. Clicking any of the mailbox or
folder names will hide all the mail-
boxes/folders.

To show or open the mailboxes/folders,
click the Tools menu and click on  Mail-
boxes. 

Pegasus Mail (v.3.x)
Creating Folders 
1. Click the File menu and select Mail

folders (see Figure 3 on page 7) or
click the Folder icon on the toolbar. 

2. The Folder Manager window will
appear. 

3. Click the New button to create a new
folder. Type the new name of the
folder then, click the OK button.

Creating Sub-folders 
1. Right click on the name of the folder

where you wish to create a sub-
folder. A new screen will appear.

2. Type the name of the sub-folder and
click the OK button.

Renaming/Deleting Folders and Sub-
folders
1. Click the File menu and select Mail

folders or click the Folder icon on the
toolbar. The Folder Manager win-
dow will appear. 

2. Select the folder to be renamed or
deleted. Click the Rename or Delete
button.  
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                                  Figure 2: Eudora Mail Client



Compacting Mailboxes and Folders
This function allows you to remove any 
wasted space on your disk.

To compact your mailboxes, click the
Special menu and select Compact Mail-
boxes.

Netscape Messenger (v.4.x)
Creating Folders
1. Click the File menu and choose New

Folder. The New Folder window will
appear. 

2. Type the  folder name then, click the 
OK button.

Creating Sub-folders
1. Right click on the folder where you

wish to create a sub-folder. A drop-
down menu will appear.

2. Click  on  New  Sub-folder.  The New 
Folder window will appear. 

3. Type the name of the new sub-folder
then, click the OK button.

Creating Folders in Shared Accounts
1. Right click on the mail server name 

(e.g. baguio.ima.com). A drop down-
menu will appear. 

2. Choose Mail Server Properties. The
Mail Server Properties window will
appear. 

3. Go to the Advanced tab and uncheck
the Show only subscribed folders
option. Then, click the OK button.

Note: You can also create sub-folders
within shared accounts/folders by
right clicking on the folder name
itself.

Deleting, Renaming and Compressing
Folders/Sub-folders
You may delete, rename and compress
folders by right clicking on the folder
name and selecting the Delete, Rename
or Compress commands.

                                                   Figure 4: Netscape Mail
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                                             Figure 3: Pegasus Mail



“The danger from comput-
ers is not that they will
eventually get as smart as
men, but we will meanwhile
agree to meet them half-
way." 
                        -Bernard Avishai

This Month’s Tip
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Updating the Internet 
Exchange License from 
Version 4 to Version 4.1

To update the Internet Exchange
license from version 4 to version
4.1,  follow the procedure below:

1. Start the Apache Web Server. To
do this, go to Start\Pro-
grams\Internet Exchange 4 and
select the Apache Web Server. 

2. Open your web browser (e.g.
Internet Explorer or Netscape Nav-
igator). 

3.  In your web browser’s  Address
field, type the URL (e.g. machine-
name.domain.com\iev4\sysad\lup-
date\index.htm) that will point to
the Internet Exchange License
Update page. After typing the
URL, press the Enter  key on your
keyboard. The License Update
Control page will appear. 

4. Click the License Manager link
on the left-hand side of the
License Control page. The IMA
License Manager screen will
appear. The screen displays the ini-
tial directory path (C:\Cert) of the
certificate file and the Internet
Exchange modules you installed in
your machine.

5. If your certificate file is located
in another directory, type the direc-
tory path of the certificate file in
the Certificate Directory field.
Then, tick the corresponding check
box of the modules to be licensed.
Click the Continue button. The
License Information page per mod-
ule will appear.  

7. Click the Update button. A
screen stating that you  have suc-
cessfully updated your license for
a particular module will appear.

      Continued on page 9 -->

Q: I created an alias name
“alias@domain.com” for my user
account “username@domain.com” in
the Internet Exchange 4.1 Directory
Server to send and receive mail. I
tried sending a message to
“alias@domain.com” but, I did not
receive any message in the “user-
name@domain.com” account Inbox.
Do you have any idea why? 

A:  You did not receive your mail using
your alias name because the Internet
Exchange Preprocessor cannot recog-
nize the alias name that you created in
the Internet Exchange Directory Server. 

To enable the Preprocessor to recognize
your alias name, you must re-build an
alias table in the Internet Exchange Pre-
processor interface. To do this, go to the
Preprocessor web interface and click
the Build Alias Table hyperlink. The
Build Alias Table screen will appear
where you should simply click the Build
Alias Table button. This operation
extracts all the mail aliases from the
Directory Server and builds a separate
database. This database is required by
the Preprocessor to recognize recipients
using their alias name. 

Building an alias table in the Internet
Exchange 4.1 Preprocessor interface
will not immediately solve this prob-
lem, however, as the alias database is
not recognized unless the Preprocessor
is shut down and re-started.  This incov-
enience has been rectified in Internet
Exchange version 4.11, which will be
released soon.  

Q: I am using Internet Exchange 4.1.
I have been receiving warning mes-
sages indicating that I have exceeded
my user quota. Suddenly, I stopped
receiving messages in my Inbox. Why
did this happen and what should I do
about this?

A:  If configured by the system adminis
trator, the Internet Exchange 4.1 Quota
Agent sends warning messages to the
individual Message Store users who
exceeds their allocated disk space. 

The warning messages that you
received were sent to you by the Quota
Agent to notify that you have exceeded
your allocated disk space. Since you
exceeded your allocated disk space,
your account was disabled.

To be able to receive messages again,
delete some of the messages in your
mailbox especially those which contain
large attachments. Then, ask your sys-
tem administrator to re-activate your
account.

Q: Our mail server consumes a lot of
time processing an employee's per-
sonal outgoing mail, which are mostly
hotmail accounts. We have a slow
connection to the Internet and I want
to be able to prioritize the delivery of
business-related mail. Is it possible to
schedule personal mail for later deliv-
ery in the Internet Exchange Messag-
ing Server 4.1?

A:  Yes, it is possible to schedule the
delivery of your messages on a per
domain basis via the Internet Exchange
SMTPC Queue Management. For
example, if you want all outgoing mes-
sages destined for hotmail to be queued
for later delivery and have the system
process it after an hour, you need to set
the following in Internet Exchange:



 Question and Answer...

    Continued from page 8 
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1. Go to the SMTPC web Interface. Once here, click the
SMTPC Queue Management link. The Queue Manage-
ment screen will appear.

2. Click the SMTP Domain Profile     button. The Peer
Domains screen   will appear. 

3. Click the New button. The Peer Domain attribute
screen will appear. 

4. Type "hotmail.com" in the Domain Name input text
box. 

5. Tick the check box of the "Queue mail before attempt-
ing delivery" and change the "Queue run interval" to
60 minutes.

Q: We are currently using the Internet Exchange Messag-
ing Server 4.1 as our main mail server. We just added two
internal Notes server with its native SMTP server
installed. These servers will host its own Internet domain
and users. I want to use the Internet Exchange virus scan-
ning capability to scan all incoming/outgoing messages
from these Notes servers. I have already pointed the MX
record of the two additional domains to the FQDN of the
Internet Exchange machine.

What do I need to add or change in Internet Exchange so
that all incoming/outgoing messages from these additional
servers will be scanned for viruses?

A:  To scan all incoming/outgoing messages from your two
additional Notes servers, you must set the following in the
Internet Exchange: 

1. Go to the Preprocessor web interface. Once here, click
the Configuration link under the Preprocessor Con-
trols. The Configuration screen will appear.

2. Add the two additional domains (e.g. domain1.com
and domain2.com) of the Notes server in the Local
Domains input text box. 

      
3. Click the Domain Forwarding link. The Domain For-

warding screen will appear.

4. Click the New button to create a Domain Forwarding
entry for the two additional domains.

5. Type the domain name (e.g. domain1.com) in the
Domain Name input text box. Select SMTPC from the
Queue Selection drop-down list. Click the Add button.

6. Follow steps 3 to 5 in creating domain2.com.

7. Add an entry for the two additional domains in the host
table  pointing  to  the  actual  IP  address of the Notes 

  server. To add an entry, open the host file “c:\win-
dows\hosts.sam” (if you are using Windows 9x) or
c:\winnt\system32\drivers\etc\hosts (if your are using
Windows NT) in notepad or any text editor.

For example:

192.168.1.1 domain1.com
192.168.1.2 domain2.com

Note: The host table location may vary depending on
the configuration set in the Host table filename found
in the SMTPC Mail Routing Configuration page. 

8. Go to the SMTPC web interface. Once here, click the
Mail Routing. The SMTPC Mail Routing Configura-
tion screen will appear. Select "Host table then DNS"
from the Name Resolution drop-down list. 

9. To configure the scanning capability of Internet Ex-
change, go to the main Preprocessor Configuration
screen and click the Anti-virus plug-in configuration
link. The Anti-virus plug-in configuration screen will
appear. Create a new anti-virus profile by clicking the
New button. The New Profile screen will appear. Click
the Help button for a detailed instruction. 

10. Set the Channel Action Matrix of the AntiVirus mod-
ule by clicking the Module List link. On the Module
List page, click the AntiVirus link. Select the SMT-
PD\SMTPC combination. Then, click the Update but-
ton.


